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Kom godt i gang med Maple 12

(Document mode)
©  Adept Scientific   2008

I Document mode har du en helt blank side at skrive på, og altså ingen røde >. Når du åbner en ny side, 
ser øverste venstre hjørne således ud

Cursoren står skråt, og er således klar til at modtage en 'matematik'-indtastning (math-mode). Et tryk på 
F5-knappen stiller cursoren lodret og klar til at modtage en tekst-indtastning (text-mode) Skriver du 
tekst, kan du ved at trykke F5 skifte til math-mode, skrive en formel eller lignende, og skifte tilbage til 
text-mode med F5 når du er færdig med formlen.

Indtastning af taludtryk - simple beregninger

Indtast i math-mode:

2C2
4

Dette blev indtastet ved i math-mode at taste 2C2 efterfulgt af Enter.

Du kan også få beregningen foretaget in-line: 2C2 = 4. Her er 2C2 indtastet i math-mode, og selve 
beregningen er foretaget ved at taste Ctrl+=. Efter resultatet er der skiftet til text-mode med F5.

Det er vigtigt, at du bliver fortrolig med Maples formeleditor. Skal du fx indtaste et udtryk som 17K2
5

,

kan du naturligvis taste ind ved at sætte en parentes om tælleren, altså som (17-2)/5

17K2
5

 = 3

Det ser bare ikke så kønt ud med denne overflødige parentes i tælleren. Men Maple kan gøre det bedre:

Sørg for, at du befinder dig i math-mode (tast evt. F5)



5. 5. 

3. 3. 

1. 1. 

4. 4. 

2. 2. 

2. 2. 

Indtast først tælleren 17K2.

Marker hele tælleren ved at trække med musen - eller alternativt: Hold Shift-tasten nede, og tryk på 
pil-venste et par gange til hele udtrykket er markeret.

Med hele tælleren markeret taster du / for division. Straks vil en pæn brøk komme frem med 
cursoren stående i nævneren.

Indtast nævneren, og tast Ctrl+=

17K2
3

 = 5

Arbejdsområde 1
Indtast ovenstående brøk og check, at alt virker som det skal. 

Indtast også udtrykket 29C17
25

C
3

7C4
. Der opstår sikkert et problem, når du skal indtaste + 

, idet din cursor er placeret i nævneren i den første brøk. Her gør pil-højre tasten underværker.

Skal du indtaste mere komplicerede udtryk, fx potenser, kvadratrødder, n-te rødder mv., så klik på pilen i
Expression-knappen (i skærmens højre side): 



    

Dette vil åbne Expression-paletten, hor du finder skabeloner til at lette indtastningen. Skal du fx skrive 
potens 24, så klikker du på knappen ab. Dette vil give dig denne skabelon i indtastningslinjen:

du indtaster et 2-tal, og trykker herefter på TAB-knappen på tastaturet. Eksponenten b vil så blive 
markeret med blåt, og du kan indtaste 4-tallet. Sådan virker i princippet alle skabeloner med mere end én
pladsholder. 

24 = 16
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Arbejdsområde 2
Eksperimenter med potens-skabelonen, og indtast herefter udtrykkene

 K3.17C 2.532
K 5.25
2.46

1K2 3
2
C 3 C3

2

Som du sikkert har bemærket, så returnerer Maple altid - om muligt - det eksakte resultat. Dvs., at hvis 
der forekommer et decimaltal i udtrykket, så returneres resultatet som et decimaltal, ellers returneres det 
eksakte resultat. Du kan tvinge Maple til at aflevere et tilnærmet resultat  således:

Hvis du skal lave en tilnærmet beregning af fx 1C 5
2

 så højre-klikker du på udtrykket, hvorved en 

kontekst sensitiv menu kommer frem. Denne menu rummer det, der vil være relevant at gøre ved 
udtrykket:



Prøv at højre-klikke på udtrykket her:

1C 5
2

Vælger du, som vist ovenfor, at approksimere med 5 cifre, får du

1C 5
2

at 5 digits
1.6180

Du kan oversætte teksten 'at 5 digits' til dansk

1C 5
2

med 5 decimaler  1.6180

Nu er en pil måske ikke den bedste måde at vise, at der er sket en approksimation, så slet pilen med 
tekst, og indsæt i stedet et ≈ (findes i Common Symbols paletten):

1C 5
2

z 1.6180

Men kan det så stadig regne? Ja! Prøv at ændre lidt i udtrykker (erstat fx 2 med 3 i nævneren). Der sker 
tilsyneladende ingenting, men hvis du genberegner ved at lade cursoren stå i udtrykket og trykker på !-
knappen, så vil udtrykket blive korrekt genberegnet:
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1C 5
3

z 1.0787

Endvidere kan du skrive tekst i stedet:

1C 5
2

 giver med 5 cifre 1.6180

Selv dette vil opdatere korrekt, hvis du ændrer i udtrykket og efterfølgende trykker på !-knappen.

Endelig kan du også selv skrive kommandoen evalf , og beregne in-line:

evalf 5 1C 5
2

 = 1.6180 

Arbejdsområde 3
Udregn nedenstående udtryk, og afgør, om de er hele tal.
OBS: π og e (den naturlige logaritmes grundtal) skal skrives vha. Common Symbols-paletten

sin 2017$ 2
5

eπ$ 163
K6403203

Regning med symbolske udtryk

Nogle symbolske udtryk reduceres automatisk - andre ikke. Fx vil automatisk reduktion ske i udtrykkene
(in-line beregning er benyttet):

xC2 xC3 xC4 yC5 yC6 y = 6 xC15 y

2 3 xC2  = 6 xC4

men ikke i 
x$ 3 xC2

Det meget vigtigt at du skriver et gange-tegn mellem  parentesen. I modsat fald vil Maple opfatte 
udtrykket som funktion med navnet x, der skal udregnes på 3 xC4.

Du kan tvinge Maple til at gange parenteser ud ( - altså at omskrive til ledform) ved at højre-klikke på 
udtrykket, og vælge expand i kontekstmenuen:
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x 3 xC4 =
expand

3 x2
C4 x

- altså en slags selv-dokumenterende beregning, hvor du kan naturligvis ændre 'expand' til noget mere 
dansk.

Den almindelige kommando-syntaks kombineret med in-line beregning kan også benyttes:

expand x 3 xC4  = 3 x2
C4 x

Brøken a2
Kb2

aCb
 kan forkortes aKb. Det ses nemmest ved at omskrive tælleren til aCb $ aKb . 

Men kan vi få Maple til det? Der sker ingen automatisk forkortning (det ville ske, hvis der kun indgik 
tal):

a2
Kb2

aCb
 = a2

Kb2

aCb

Expand giver heller ikke det ønskede, men naturligvis det forventede, idet brøken nu er skrevet som en 
differens af to led (altså bragt på ledform).

a2
Kb2

aCb
=

 expand a2

aCb
K

b2

aCb

Derimod er kommandoen normal skabt til opgaven. 

a2
Kb2

aCb
normal aKb

Kommandoen simplify kan også bruges her (Prøv!). Denne forenkler - om muligt - udtrykket mest 
muligt. Dette kan også indbefatte at gange parenteser ud. Den almindelige kommando-syntaks 
kombineret med in-line beregning kan også benyttes:

normal a2
Kb2

aCb
 = aKb

Den sidste kommando til manipulation af symbolske udtryk, vi vil se på her, er factor, der faktoriserer et 
symbolsk udtryk:

a2
Kb2 =

 factor 
aKb  aCb

x2
C4 xC3 =

 factor 
xC3  xC1

Arbejdsområde 4

Omskriv med passende Maple kommandoer kvadratet på en to-leddet størrelse aCb 2 til formen
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a2
Cb2

C2 a$b

Addition af talbrøker , fx 2
3
C

5
7

, vil altid ske automatisk i Maple. Prøv! Derimod er der ingen 

automatik, hvis du forsøger dig med fx 1
a
C

1
b

. Hvordan skal man så få dem på fælles brøkstreg?

Variabler og formler

Du gemmer et udtryk i en variabel ved at benytte tildelingssymbolet :=, der er et kolon efterfulgt af et 
lighedstegn. Fx vil tildelingen (der er sat et kolon efter tildelingen for at undgå Maples respons på 
tildelingen): 

abc d 14 x3
C

7
x$y3 :

bevirke, at udtrykket 14 x3
C

7
x$y3  gemmes i variablen abc. Herefter kan abc benyttes i stedet for det 

oprindelige udtryk. Fx
abc
7

 = 2 x3
C

1
x y3

Læg mærke til, at det er det symbolske udtryk, der gemmes i variablen abc. Hvis x og y får tildelelt 
talværdier, så vil abc beregnes til en talværdi. Tildel x værdien 2, og y værdien 3. Dette sker også med 
tildelingssymbolet := 

x d 2 : y d 3 :

hvor kolon (:) efter tildelingerne betyder, at vi ikke ønsker at se output, der jo blot ville være i stil med 
x = 2 og y = 3. Beregner du nu abc, får du et tal:

abc = 6055
54

Når du tildeler værdi med x d 2 og y d 3, så har x og y disse værdier indtil du giver dem nye værdier 
ved en ny tildeling. Da specielt  x og y ofte benyttes i beregninger, er det ikke smart, at de har faste 
værdier. Du kan rense  x og y ved at skrive:

x d'x ': y d'y ':

Du kan lave en tildeling af værdier til  x og y, der kun er aktiv så længe beregningen af abc står på. Dette 
kaldes en lokal tildeling. Hertil kan du benytte eval - kommandoen:

eval abc, x = 2, y = 3  = 6055
54

Alternativt kan du benytte skabelonen
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fra Expression-paletten. Denne udfyldes således:

abc
x = 2, y = 3

 = 6055
54

Arbejdsområde 5

Prøv at tildele nye værdier til x og y ovenfor  (husk at trykke på !-knappen efter tildelingen mens 
du stadig befinder dig i linjen - ellers bliver linjen ikke udført). 
Beregn så abc ved at gå til linjen med abc, og tryk på !-knappen

Rumfanget af en tønde med højde h, radius R og endefladeradius r beregnes med formlen: 

V =
π$h
15

8 R2
C4 r$RC3r2  

  Find rumfanget af en tønde, når h = 11, r = 4 og R = 5. Prøv med begge former for tildeling.

Undertiden får du behov for at få Maple til at glemme alle tildelinger, du har lavet. Dette klarer du nemt 
ved at fyre restart kommandoen af (der kommer ingen output fra denne kommando):

restart
abc, r, R

abc, r, R

Som det ses, har Maple glemt alt om tildelingen af værdier til variablerne abc, r og R. Du kan føje 
kommentarer til en kommando linje ved at placere # foran kommentaren, fx

restart #Maple glemmer alt

Ligningsløsning

Ligningsløsning går for det meste let og smertefrit i Maple, men dog langt fra altid! Du skal nu løse 
ligningen 
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x = 1
xK1

Højre-klik på ligningen, og vælg menupunktet solve. Så ser du en liste over de muligheder du har:

Vi nøjes her med at se på de 3 sidste muligheder:

x = 1
xK1

solutions for x 1
2
C

1
2

 5 , 1
2
K

1
2

 5

x = 1
xK1

solve x = 1
2
C

1
2

 5 , x = 1
2
K

1
2

 5

x = 1
xK1

solve for x x = 1
2
C

1
2

 5 , x = 1
2
K

1
2

 5

Blandt disse vælger man den, der i den konkrete situation giver den mest bekvemme form. 

Men hvordan får vi plukket en specifik løsning ud, fx den positive, og får denne tildelt navnet L1:

x = 1
xK1

solve x = 1
2
C

1
2

 5 , x = 1
2
K

1
2

 5
select entry 1

x = 1
2
C

1
2

 5
assign to L1

x = 1
2
C

1
2

 5

Dette laves således:

Højre-klik på resultatet af solve, og vælg menupunktet Select Element > 1.

Højre-klik på resultatet af select entry 1, og vælg menupunktet Assign to a Name. Dette kalder en 
dialogboks frem, hvor du skal indtaste det ønskede navn
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Du kan checke, om alt er i orden ved at udregne L1:

L1 = x = 1
2
C

1
2

 5

Alternativ metode:

L d solve x = 1
xK1

, x  = 1
2

C
1
2

 5 , 1
2
K

1
2

 5

L1 = 1
2

C
1
2

 5

Her navngives løsningerne, der returneres fra solve, med L. Elementerne i L udtrækkes med L 1  for det 
første element, og L 2  for det andet. I stedet for L 1  kan du skrive L1, hvor indekset er lavet med L_1.

Løsning af flere ligninger med flere ubekendte sker tilsvarende, blot skal du samle ligningerne i krøllede 
parenteser {}, og tilsvarende for de variabler, du løser med hensyn til.  Et eksempel:

Løs ligningssystemet: 

 
x2
C2 xCy2

K4 y = 3

y = 4 x

Af hensyn til overskueligheden (og senere reference), navngiver vi ligningerne:

lign1 d x2
C2 xCy2

K4 y = 3 :
lign2 d y = 4 x :
 L d solve lign1, lign2 , x, y

x =K
3
17

, y =K
12
17

, x = 1, y = 4

Løsningerne er altså K
3
17

,K12
17

 og 1, 4 . Geometrisk svarer denne opgave til at finde 

skæringspunkterne mellem en cirkel og ret linje.
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Arbejdsområde 6

Løs den generelle andegradsligning a$x2
Cb$xCc = 0 med hensyn til x.

Løs ligningssystemet (med hensyn til x og y):

xCy = a

KyC4 x = b

Tildel a og b nogle værdier, og løs ovenstående ligningssystem igen.

Isoler R, r og h i  ligningen (benyt Isolate Expression for):

V =
π$h
15

8 R2
C4 r$RC3r2

Højre-klik på ligningen

2 x$ xK3 C4 = 2 x2
K3 $ xK2

og vælg Manipulate Equation i kontekstmenuen. Du får da en dialogboks frem, hvor du kan manipulere 
ligningen. Eksperimenter med mulighederne. Når dialogen afsluttes kan Maple skrive alle skridt:

2 x$ xK3 C4 = 2 x2
K3 $ xK2

manipulate equation

2 x xK3 C4 = 2 x2
K3 xC6

2 x xK3 K2K2 x2
C3 x = 0

K3 xK2 = 0
K3 x = 2

x =K
2
3

Uligheder

Uligheder løses ligesom ligninger - blot skal du anvende et ulighedstegn: <, >, ≤ eller ≥  - hvor de første 
to sidder på tastaturet, mens de to sidste findes i Common-symbols paletten.

Lad os se på et eksempel:
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(9)(9)

(6)(6)

(10)(10)

(7)(7)

solve K
1
2

x2
K6 xK16 % 2 xC14, x

RealRange KN, K10 , RealRange K6, N

Løsningen skal her opfattes som KN,K10 g K6,N . 

solve K
1
2

x2
K6 xK16 ! 2 xC14, x

RealRange KN, Open K10 , RealRange Open K6 , N

Her skal løsningen tilsvarende opfattes som KN,K10 g K6,N . 

Labels

Du har sikkert bemærket de numre, der står ud for nogle af resultaterne i højre side af skærmen. Disse 
numre kaldes Labels, og dem kan du bruge, når du vil referere til tidligere resultater. Disse resultater kan
være tal, tildelinger, løsninger mv.

2C3  #resultatet bliver et tal
5

v d xCyCz  #resultatet bliver en tildeling
xCyCz

solve x2
C2 xK2 = 0, x   #resultatet bliver en udtryksfølge

K1C 3 , K1K 3

Hvis du vil referere til et af disse resultater, taster du Ctrl+l (dvs, du holder Ctrl-tasten nede, og trykker 
på l). Dette bevirker, at en lille boks popper op:

I Label Value feltet skriver du nummeret - uden parenteser! Labels opdateres automatisk, hvis du putter 
en ny udregning ind i en eksisterende følge. 

For at se, hvad de enkelte labels rummer, udregnes disse (husk, at dette skal foregå i math-mode):

(7)
5



(11)(11)

(14)(14)

(12)(12)

(13)(13)

(8)
xCyCz

(9)
K1C 3 , K1K 3

Labels kan indgå lige som variabler i udtryk (under forudsætning af, at det giver mening):

(7)2C(9)1
2

25C K1C 3
2

hvor (9)1 er det første element i udtryksfølgen (9).

Funktioner

Funktioner i Maple skal defineres efter syntaksen

f d x/udtryk i x

Du kan benytte skabelonen  f := a / y fra Expression-paletten når du skal definere funktioner, men da 
du skkert ofte kommer ud for at skulle definere en funktion, kan du lige så godt lære genvejen med det 
samme: Pilen laves ved at taste ->  (altså en bindestreg efterfulgt af et 'større end' tegn).

Definer en funktion ved:

f d x/x2
K2 xC5

x/x2
K2 xC5

Herefter er funktionen klar til brug. Du kan fx udregne nogle funtionsværdier:

f 2  = 5

f 5 C3  = 5 C3
2
K2 5 K1

f aCb  = aCb 2
K2 aK2 bC5

Der er et væld af funktioner indbgget i Maple. Du kan få en oversigt i hjælpesiderne, som du får adgang 
til via menuen Help > Maple Help. Prøv her at søge efter function, og find oversigten function,index i 
søgeresultaterne. 

Hvis du ved, hvad du skal have fat i fra hjælpesiderne, kan du med ?-kommandoen få den ønskede 
hjælpeside frem straks:

 
?index,function

Hvis du prøver at definere en funktion ved  f x d udtryk i x, brokker Maple sig, og beder dig bekræfte,
at det er en funktion, du er i færd med at definere.
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(16)(16)

(17)(17)

Ofte udelader man i matematik at skrive gangetegn mellem en variabel og en parentes, fx skriver man 
a bCc , selvom man faktisk mener a$ bCc . Den går ikke i Maple! 

a$ cCb
a cCb

a cCb
a cCb

Læg mærke til forskellen i output. Maple skriver ikke gangetegnet i (15), men sætter i stedet et lille 
mellemrum ind. I (16) opfattes a som navnet på en funktion, der skal anvendes på summen aCb. Gør 
det derfor til en vane, at skrive alle gangetegn - undtagen dem, der står mellem et tal og en variabel, som 
fx 2 x. 

I Maple skal du bruge funktionsparenteser. I matematikbøger skriver man ofte fx ln x i stedet for ln x , 
og tilsvarende sin x i stedet for sin x . Det går ikke i Maple!

Arbejdsområde 7
En parabel går gennem punkterne 1, 2 , 2, 1  og 3, 3 . Find forskriften.
Vejledning: Start med i Maple at definere det generelle andengradspolynomium ved  
p x = ax2

CbxCc, og opskriv vha. forskriften de 3 ligninger med 3 ubekendte, de givne punkter 
giver anledning til. Løs dette ligningssystem.

Graftegning

Det er meget simpelt at tegne funktionsgrafer i Maple. En enkelt kommando - plot - klarer det meste. 
Definer en funktion ved

f d x/x2
K6

x/x2
K6

Grafen kan tegnes i et standardvinduet, hvor x-intervallet er K10, 10 , og y-intervallet er tilpasset x-
intervallet (Autoskaleret).

plot f x



x
K10 K5 0 5 10

10

20

30

40

50

60

70

80

90

Hvis du vil ændre x-intervallet, angiver du dette som en parameter til plotkommandoen. Fx skal x-
intervallet K5, 5  angives som x =K5 ..5, hvor de to prikker laves med to tryk på punktum-tasten.

plot f x , x =K5 ..5



x
K4 K2 0 2 4

K5

5

10

15

Tilsvarende kan du kontrollere y-intervallet

plot f x , x =K5 ..5, y =K10 ..10
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x
K4 K2 0 2 4

y

K10

K5

5

10

Hvis du vil tegne en graf mere i samme koordinatsystem, så skal pakke de to funktioner sammen med [] 
eller {}. Benyt {}, hvis den rækkefølge, hvori graferne tegnes, er ligegyldig:

g d x/K
3
2

xC2

x/K
3
2

 xC2

plot f x , g x , x =K5 ..5, y =K10 ..10



x
K4 K2 0 2 4

y

K10

K5

5

10

Arbejdsområde 8
Klik i graffeltet ovenfor. I det aktive grafområde bliver markøren til et sigtekorn. Før sigtekornet hen 
til et af skæringspunkterne, og du kan aflæse nogle tilnærmede værdier øverst i Maplevinduet:

I dette vindue kan du lave en række ændringer i koordinatsystemet. Afprøv nogle af disse 
muligheder.

Hvis du med sigtekornet klikker på en af graferne, markeres denne. Ved et højre-klik kan du så åbne 
for kontekst-menuen, hvor du finder en række indstillinger for den enkelte graf. Skift fx farve og 
tykkelse.

Klik på Drawing-knappen, så skifter menuen til denne
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Her kan du fx tilføje tekst til dine grafer. Prøv.

Alle ændringer, du har lavet ovenfor, er midlertidige. Hvis du gentegner plottet (gå til plot-
kommandoen ovenfor, og tast Enter), så forvinder alle dine ændringer. Skal ændringerne være 
permanente, så skal de tilføjes selve plot-kommandoen. Hvis farverne skal være rød og blå, ændres 
plot-kommandoen til (fjern : i slutningen af linjen og taste Enter, hvis du vil se plottet)

plot f x , g x , x =K5 ..5, y =K10 ..10, color = blue, green

Er farverækkefølgen den forventede? Ellers lav de fornødne ændringer.
Vil du lave stiplede linjer mm. er kommandoen denne:

plot f x , g x , x =K5 ..5, y =K10 ..10, color = blue, green , linestyle = dash, solid

Alle detaljer finder du her

?plot,options

I Document mode findes en helt anden metode, hvor funktionsudtrykkene blot trækkes (kopieres) over i 
et koordinatsystem. 
Lad der være givet to funktioner ved:

f d x/x2
K6

x/x2
K6

g d x/K
3
2

xC2

x/K
3
2

 xC2

Indsæt et koordinatsystem via Insert > Plot > 2D:



K10 K5 0 5 10

K10

K5

5

10

Marker funktionsudtrykket i f - det skal se sådan ud

Hold Ctrl-tasten nede og træk det markerede udtryk  til koordinatsystemet, og slip det. Da vil grafen for
f tegnes. Gør tilsvarende med funktionsudtrykket i g. Resultatet bliver 
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K10 K5 0 5 10

20

40

60

80

Du kan formatere grafen ved at højre-klikke i den, og vælge menupunktet Axes > Properties, hvis du vil 
bruge et andet interval end K10, 10 . Prøv at ændre intervallet til K5, 5 . Eksperimenter med de andre 
muligheder.

Eksempel - Overlevelse

Nedenstående funktion er et eksempel på en såkaldt overlevelseskurve

restart
L d x/100$e0.0005 1Kx K0.000867 1.0914xK1.0914

x/100 e0.0005 1Kx C K1 $0.000867 1.0914xK1.0914

Fx er L 65  = 75,10. Dette skal tolkes således, at ved en alder på 65 år er 75% i live, altså 25% er døde.
Grafen ser således ud:
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Overlevelseskurve

Grafen er fremstillet ved at trække funktionsudtrykket til et indsat koordinatsystem. Indstilling af akser, 
akselabels, titel mv. laves alt sammen i Plot >, der kan vælges som menupunkt når grafen højre-klikkes.

Arbejdsområde 9
Hvor stor en procentdel er i live efter 80 år?

Hvornår er halvdelen faldet fra?

I hvilket år er dødeligheden størst?
Vejledning: Se på funktionen d x = L xC1 KL x , og indtegn denne i et nyt 
koordinatsystem. 

Vi vil nu prøve at undersøge betydningen af konstanten 0.005 i forskriften for L. Derfor parametriserer vi



(23)(23)

L med hensyn til denne konstant, og kalder den nye funktion L1. Denne er så en funktion af to variabler:

L1 d x, A /100$eA$ 1Kx K0.000867 1.0914xK1.0914

x, A /100 eA 1Kx C K1 $0.000867 1.0914xK1.0914

L1 x, 0.0005  er således identisk med funktionen L x .  Vi tegner L1 for forskellige værdier af A:

L1 x, 0.01  = 100 e0.0109462438K0.01 xK0.000867 1.0914x

L1 x, 0.005  = 100 e0.0059462438K0.005 xK0.000867 1.0914x

L1 x, 0.0005  = 100 e0.0014462438K0.0005 xK0.000867 1.0914x

Indsæt et koordinatsystem, og træk de tre funktionsudtryk til koordinatsystemet
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Grafen for L1 bliver en 3D-flade, og de tre kurver, vi har tegnet ovenfor, kan opfattes som snit i denne 
flade. Lokalisér disse snit i fladen nedenfor.
Du kan tegne 3D plots ligesom 2D plots ved at trække funktionsudtrykket over i koordinatsystemet, men



her er kommandoversionen den best bekvemme:

plot3d L1 x, A , x = 0 ..100, A = 0 ..0.05, axes = Framed
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Du kan rotere fladen ved at trække i den
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Differentialregning

Maple kan naturligvis også differentiere symbolsk. Til udregning af differentialkvotienter benyttes 

skabelonen  d
d x

f  fra Expression-paletten. Benyt tabulatoren til at hoppe fra pladsholder til pladsholder 

ved udfyldningen:

d
d x

 x2 = 2 x

d
d x

 2 x3
CeK2 x  = 6 x2

K2 eK2 x

Ofte har du allerede defineret en funktion som fx

 f d x/ex
K2 xK2 = x/ex

K2 xK2 



og skal bruge den afledede funktion. Denne har du direkte adgang til via f':

            f ' x  = ex
K2

Herefter kan du bruge den afledede funktion f ' som enhver anden funktion - herunder fx bestemme 
bestemme nulpunkter

f ' x = 0 isolate for x x = ln 2

Meget illustrativt kan det også være at tegne grafen for f' sammen med grafen for f. Læg mærke til, at 
der, hvor f ' er negativ, er f aftagende, og der, hvor f' er positiv, er grafen for f voksende. Desuden har f 
vandret tangent i de punkter, hvor f ' er lig med 0.

f x df x

K3 K2 K1 0 1 2 3

K2
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Du kan nemt finde en tangent til grafen for f i punktet med 1. koordinaten x = 2 vha tangentligningen:

t d x/f ' 2 $ xK2 C f 2



(24)(24)x/ d
dx

 f x

x = 2

 xK2 Cf 2

  t x  = e2
K2  xK2 Ce2

K6

Udtrykket for tangenten kopieres til koordinatsystemet ovenfor.

Arbejdsområde 10
Find vha. differentialregning maksimum og minimum for funktionen

f x = x
x2
C3

og tegn grafen for f og for den afledede funktion i samme koordinatsystem.

Gå dernæst til Tools > Tutors > Calculus - Single Variable > Curve Analysis, og skift 
standardfunktionen ud med funktionen ovenfor. Udforsk dette værktøj.


